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Paratext Cookbook for Consultants

A Consultant should be able to

Utilize the Help files available in the Paratext Suite of tools
Backup and Restore Paratext projects

Send and receive Paratext backup files

Use Send/Receive via Internet and USB/Network to share projects
Adjust Paratext Window settings to view several projects at once
Compare two projects

Insert and Edit notes using the version 7 Notes Tool

Create, using an appropriate style sheet, a Consultant's Notes project to be able to send notes back to the translator
Import a Word file

Run basic checks under the Checking Menu

Use the tools to verify Keyterms and Parallel Passages

Use the Spelling/Wordlist tool

Identify who to go to for Paratext and/or general computer help

Using the Helps

There are new helps available in Paratext 7. Click on Help and then Browse Help to look for help on particular topics.
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£ How do | open a Source Language Text Window?

From the File menu, select Open Source Language Text... The source language tex..
i How do | open a Source Language Dictionarny?

From the File menu, select Open Source Language Dictionany.... Select the desi..
= What is a Source Language Text Window?

A Source Language Text window provides a way of working with the Hebrew, Aramaic...

* What is a Source Language Dictionary Window?
A Source Language Dictionary Window allows vou to view information from one oft...

I Introduction to the Biblical Terms toaol
The Biblical Terms tool assists Bible translators and consultants with the proce...

= YWhat is a source text?
A scurce text is a text from which a translation is made. The language ofa ..

. B> Paratext 7 Help
Welcome to Paratext 7 Help Click Update Help, in the Help menu, to ensure ..

E= Installation issue: Paratext 6.1 crashes after Paratext 7 with SLT is installed
Faratext 6.1 {SP1e or earlier) will fail to start if the Paratext ¥ Source Langu...

£ How do | change the view in the Source Text tab?
By default, the Source Text talin a source language text window displays the fo...
' i

It may be necessary to use Help|Update Help to update to the most current version of available helps.
Many windows have “Guides” that provide additional help on the window options. Look for a “Show Guide” in the
lower right of the window.

There are videos available for certain topics at: http://ubs-icap.org/chm/paratext/video/

User Interface
As is common to most Windows software there are sometimes multiple ways to “do” the same task:

use a menu

use an icon

use a shortcut

use the right click menu.

The menu structure changes depending on which window is currently active.

Some menu items open new windows and other menu items open separate programs. This can be different depending
on how the item was opened.

Notes, Parallel Passages, Biblical Renderings, Interlinear, Compare Texts, and Text Resources open as windows within
Paratext 7.1.

The following “Tools” are separate programs: Wordlist, Biblical Terms, Checklists

The User Interface can be changed to a different language using Tools|Options...

The User Interface can be localized to a new language using Tools|Advanced Options|Localization. New
localizations can be exported and shared with other users.


http://ubs-icap.org/chm/paratext/video/
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Using Views to work with text

Paratext 7 introduced new “views” to help with the editing process. These can be accessed using the View menu
or CTRL+E when a text window is active.
Unformatted - standard USFM marker view
Standard - text has “formatting”, but the markers are visible. Green color indicates that the marker is valid, red
indicates that the marker is invalid for the location or is an unknown marker. In Standard view it is not possible to
enter multiple spaces and entering markers opens a help window that shows what markers are permitted in the
entry point.
Preview - text has “formatting”, but no markers are visible. The text is not editable in Preview view.
Basic - looks like “Standard” except that the markers are “protected”.
There are three views to look at footnotes - Preview with Notes, Footnote and Cross References, Preview of
Footnotes and Cross References.
Footnotes and Cross references are only editable in Unformatted, Standard and Basic views. Double clicking on a
footnote in Standard view will open the footnote editing window.

Setting up the “Windows”

You can change the layout of the Paratext windows using commands under the Window menu.
PT 7 has 3 “flavors” of stacked windows — 1, 2 or 3 column. In stacked mode you can not change the order in which
the windows appear without closing and reopening the windows.
To view projects “side-by-side” you must first switch to “Unstacked” (under the Window menu) and then
click Window|Tile Vertical (or Horizontal)
Each time a new project is opened it may be necessary to tile the windows again so that they are all visible
Windows are ordered from Left to Right in reverse order of how they are clicked. The “last” window clicked will be
put in the upper left corner.
Only three windows can be tiled vertically. When a 4th window is opened the tiling becomes two by two.
It can be very helpful to save desktop combinations that are frequently used.
Setup the windows on the desktop as you want them saved
Click on Window|Save Texts Combination
Choose the number for the setting from the drop down list and give the setting a name.
PT 7 has a new window called the “Text Collection”. This window allows you to view a number of resources in a
single window. See the section on Text Collections for more information.
PT 7.3 has a new feature called Simplified Paratext menus. A project administrator can apply this to simplify the
menu for specified users of his or her project. See the Paratext help file for details. This replaces the Safe Mode view
in earlier versions of Paratext 7.

Text Collections

The Text Collection window is opened under File|Open Project/Resource in Text Collection...

Multiple texts can be added to a collection and the sorted using the arrows in the window. In the Select Texts window,
the left pane can be sorted by name or by language - this allows the user to sort all projects of a certain language
type together.



Collections can be saved for later use by typing in a name for the collection and clicking on the save icon of
the Select Texts window.

The Text Collection window is made up of two panes.

The left pane shows the current verse of each project or resource in the window.

The right pane shows an expanded view of whichever resource is selected by clicking on the short name.
The Text Collection window can be modified within Paratext by using the Right mouse button.

The right pane can be opened or closed by clicking on the Text Collection window and then either:
Clicking View and then clicking on Two Panes

Using CTRL+E

Opening versus Changing a Project

Clicking on the Project name in the toolbar and selecting a Project “changes” the project in the active window.
Clicking on File|Open (or the little File Open icon in the Toolbar) allows you to “Open” a new window with a project.

Synchronizing Windows

Project windows can be synchronized in five groups (a,b,c,d,e) or not at all. Synchronizing two or more windows allows
them to scroll together.

To change the synchronization on a window
Click the window so that it is “active”
Click on the “Synchronization” button on the toolbar (this is to the left of the project name and is by default “A”
From the drop down menu select the synchronization that you want for the window

Using synchronization it is possible to have different books open at the same time

Starting a “New” Project

New projects can be started for a variety of reasons:
Translation
Back-translation
Notes / Consulting
Any project where “canonical order” is needed
Projects that do not require “canonical order”
There are at least 4 ways to start a project:
From Scratch
A truly “new” project
An existing project where the encoding needs to change (ANSI to Unicode)
Restoring an existing backup .zip file
Creating a “new” project in Paratext
Copying from an existing project to a new project
Using Project|Copy Book(s)...
Send/Receive, in version 7.1
Administrator has shared the project with the registered user
User does File|Send/Receive to receive the project

Starting From Scratch

To start a new translation from scratch Paratext needs some minimal basic information:



What versification system will be used (this affects the chapter/verse check)
If in doubt as to the correct versification - leave this with the default.
What language will be used (includes characters, punctuation, fonts)
In the character sort order the order must be set as “lower/upper” (a/A) for the Spell Check tool to work correctly.
See the section on Setting up the Language Properties for more information.
What encoding (set of rules to represent character data) is used? It is recommended that you accept the default
encoding.

It is important that if you are going to use Unicode as the encoding, it be set at the time of setting up
the program. While other options can be changed later, the encoding is difficult to change.

It is not “necessary” that projects be done using Unicode encoding. The world is moving that way, but
we are not fully there. Projects can be done using legacy fonts. However, the encoding must be set
correctly from the start!

A set of rules that specify how each character in your text is stored in your computer in terms of bytes or bytes
sequences.

Click on File|New Project to start a new project from scratch
Fill in the Full and Short name of the project. Note that it is good to use the Ethnologue code for the Short Name. The
Short Name is used for the folder where the files are saved as well as for the file names.

For a consulting project you might do something like adding the letters “CN” to the short name.

Unlike previous versions of Paratext, once the project is created you can not change the short name.

Fill in the Project Properties.
Style sheet
USFM.STY is the default style that works best with the current publishing tools. However, this style sheet can be
changed.
See the section on Using Style sheets for more information.
Versification
Language (see below in the section on Setting up the Language Properties)
Change Encoding “if” necessary
The new project will open in a window in which you see two buttons: Create Book(s) and Import Book(s).
If you have Plain Text files with previously translated text and marked with Standard Format Codes use the Import
Book(s) button to import those files.
If you are starting a translation (or consulting project) for the first time use the Create Book(s) button and create
the book that you want to start translating.

If the project is being started with files previously edited in another program (Word, Toolbox, etc) then
the files:

Must be Plain Text
Have the correct \id lines with the three character book codes



Have as a minimum the \c and \v markers in the appropriate locations

Setting up the Language Properties

If a “Language” already exists you can select it from the drop down menu. This might be the case if you are creating a
Notes project and using Spanish or English for the Language.
If you need to create a “new” language for a project:
Open the Project Properties (under Project)
Click on the New... button to the right of Language
Select the Font and Size
Click on the Alphabetic Characters tab
This will normally start out blank. You can use the Copy characters... button to copy characters from another
project or you can key the characters directly. You should include all characters that could occur in the project
(keeping in mind that even if the project doesn't use a letter that letter could show up in a note or some other
context).
Note that the characters should be entered as lowercase/upper case. If you have a double character (such as ch)
the slash will disappear after the settings are saved.
The Other Characters tab has places where you can enter additional characters - such as the hyphen. You can
also set the diacritic order if you are using Unicode or if your diacritics are separate from your base characters.

If different projects use the same Language Properties then any change made in one project will affect
all the other projects using that Language Property. Sometimes it is best to create a new Language
Property if you think will need to change items (font, size, character set).

Enabling and Disabling Editing in a Project

It is often useful to “Disable” the ability to edit a project. This might be true with a back translation or if the translator
sends the actual files (and you don't want to accidentally change the files).

In the Project|Project Properties settings — un-check the button for Editing Enabled.

To re-enable editing — check the box for Editing Enabled.

Paratext 7.1 can control editing by the Projects|Users, Roles and Permissions... options. With this option editing
can be turned on or off for a particular book or chapter or for specific a user(s). The Editing Enabled option

under Project|Project Properties is superseded by the Users, Roles and Permissions... options.

Creating a Backup File

Backup using File|Backup is an important part of the translation process and should be done regularly (minimally
once a week). Paratext 7 no longer warns the user to do a backup after 7 days.

The backup should be saved to the hard drive (I recommend using a folder called \backup under the \My Paratext
Projects folder). It can then be copied to an external drive (or memory stick) or sent to an external source by email.
Paratext automatically adds the date to the backup zip file so that the standard name is something like: cnt
2010-02-16.zip

Paratext 7.1 will also have a backup to Internet option. However, this is similar to the Send/Receive option.



Restoring a Project from a Backup

File|Restore can be used to install a project where a backup .zip file of that project exists.
Paratext 7 will identify files that already exist on the Hard Drive and suggest which files should be copied. You can
select the files you want to copy into the project or you can create a “New Project...”.
Sometimes it is useful to restore a project to a new project so that the files can be compared for changes (more on
this under the section on Comparing Projects).

Copying a Project to a New Project

The third way to begin a new project is to use the Project|Copy Book(s)

In the options window choose a New Project for the copy and complete the rest of the information.

The Project properties will be identical to the properties of the original project.
This could be useful in making a copy of the back translation project so that you could make comments directly into
the back translation.
| often use this feature if | have an existing project with properties (Style sheet, Versification, Language, and
Encoding) that | want to duplicate and | have files sent by a translator that are not currently in Paratext format.

| copy one book into the new project to create the project (changing the name for the new Project)

Then import the books that have been sent by the translator (including the book that | previously “copied” from
the original project).

Using Style sheets

The Style sheet can be changed in the Project Properties and Settings found under Tools.
The Style sheet controls the “validity” of markers and the “format” of the text in “Formatted View”. If a marker is not
in the applied style sheet then it will not appear correctly in “Formatted View".
The current “preferred” style sheet for translation is USFM.STY. This style sheet contains the markers that are used in
the current typesetting process.
Documentation for the USFM.STY can be found in PDF format at:
http://confluence.ubs-icap.org/display/USFM/Home
Style sheets can be changed in the Project Properties and Settings Dialog
CUSTOM.STY is a special style sheet that can be placed in a project folder to modify styles without changing the
underlying style of the project. This can be used for color or other properties.
A CUSTOM.STY style sheet might include something like the following:

\Marker c

\color 8404992 //Note that this only changes the color of the \c//
\Marker ms3

\color 16384

\Justification Left

\Marker sl

\color 128

\Justification Left

\LeftMargin .05

Sending Files “back and forth” — the “Old Way”

Once a project has been backed up, it is possible to send the files via email.

Sending backup files by email

Locate the file using Windows Explorer and right click on the backup file. Choose Send to|Mail recipient (you must
have a valid POP3 mail program - like Outlook Express - running on your computer for this to work.


http://wiki.lingtransoft.info/doku.php?id=tutorials:paratext:paratext-7-guide#comparing_projects

A message should be automatically prepared with the file attached. Just fill in the other information and send the
message. (Note that the message will not actually be sent until the next time you send email).
Or
Open your email program and create an email.
Attach the backup file.

Receiving a backup file by email

Open the message containing the backup file.

Right click on the file attachment and then choose “Save As”

Save the file to the folder where backups are stored (\My Paratext Projects\Backup). The file will then be available to
“Restore”.

Files can also be copied from the Backup folder to a memory stick or CD as needed.

Sending Files “back and forth” — the “New Way”

Paratext 7 has incorporated a system of “version control” that allows for sending only changes to a project to the
Internet, a network drive or USB device.
Using File|Send/Receive Projects you can send files to the Internet, or a Network or USB device.
NOTE: It is very important that everyone using this method of working with files understand that
changes made to one project will be reflected to the other computers sharing the project! It is CRITICAL
that someone act as the “Administrator” of the project and determine which files are the best.
Before using the Send/Receive it should be determined where the best files reside and use those files as the base.
This may require that some work be done to compile the project.
There is other documentation on using the Send/Receive feature. Look for the Project Sharing
Manual at http://paratext.org/support/documentation, available in English, French, Spanish and Portuguese.
Since Version 7.1, Paratext requires that you indicate understanding of how Send/Receive works before a project can
be shared. This helps to insure that care is taken in setting up a Send/Receive. Once all of the boxes are checked, the
next menu allows the Administrator to Add users, and Assign Books, or Chapters.
Users can be added as:
Administrators
Translators
Consultants
Observers
Book that are not assigned to a translator are not editable by that translator.
When assigning books the Administrator can assign chapters by clicking on a book name.
Basic Process for Consultant Use
Both Translator and Consultant should have the same version of Paratext installed.
Translator/Administrator sets up the project users and books and "sends” the project. Note: if the project
existed on other computers it should be removed before beginning this process. The process should
be started with the project only existing on the Administrator's computer.
Consultant receives the project using File|Send/Receive Projects. The first time the project is received there will
be a notification that the project is being added.
Once the consultant has received the project they can either insert notes using a Consultant's Notes Project or
using the Paratext 7 Notes.
By clicking on File|Send/Receive... the consultant and translator can send “changes” to the files back and forth
over the internet. Any changes to the project get updated automatically in the other computers using the project.

Copy or Import

If files are sent in their “native” Paratext format they can be simply copied to the project folder (if that file already
exists) or saved to a temporary folder and imported into the project using "Project|Import Books...". If you copy a


http://paratext.org/support/documentation

file into a project and the file is not in “Plain Text” format, the file will fail to open.

It is also possible to send single (or multiple files) without a backup, but it is generally better to send the files in the
Paratext .zip format. This allows for easier restoring.

When “importing” a file, it is not necessary that the file have the same name as the original.
The file should be in USFM (standard format) with at least \c and \v markers.
If the file already exists in the project a window should pop-up indicating that the file will be changed.
If the file does not already exist it will be added.
When working with “extra” files like the glossary, topical index, etc there can be problems with restoring files from PT

6.0 to PT6.1. In this case it is possible to use an “Unzipping” program (like WinZip) to unzip the backup to a temporary
folder and then use import to bring the file into the correct project.

Working with “Word” documents

Occasionally a translator will send a back translation or scripture text in Word document form rather than as a
Paratext file. The best procedure is to ask the translator to save the file as a text document and resend it. If the file
has special formatting, the formatting is lost in saving the file as Plain text and so you may not be able to do much
with the file in Paratext.

If you have a scripture text in a Word file:
Open the file in Word.
Make sure that the first line of the file is an \id line with the 3 character book code — \id MAT.
As a minimum, the file should have \c and \v markers to be usable in Paratext.
Click on File|Save As.
Change the “Save As Type” to “Plain Text (txt)” — this will cause the name to change to a txt file.
Close Word.
Open Paratext and go to the project where you want to import the file.
Choose File|lmport.
Locate the file and click OK. The file should be added to the project. If a book by that name already exists in the
project you will be advised that the book will be changed.

Comparing Projects

Two projects can be compared by using the Tools|Compare Texts menu.

The current version of the project that is “active” when “Compare Texts” is activated becomes the “base” for showing
changes.

In the right hand side of the window you can select either another version of the project or another project.

The compare window shows places where the text has changed.

By clicking on the left and right “blue” arrows on the window toolbar you can move to the previous or next change.

Right clicking on a change opens a menu to allow undoing a given change or all changes in the chapter. NOTE: this
only works if the text in the left pane is the “Current Version”.

Using Lists (Saving and Opening)

Lists are created by various checks and the “Search” tool. It is possible to save the lists as *.ref files to be looked at
later.

It is possible to create a list and send it to someone else.
Click on the List window and then click File|Save (Make sure of the name and location of the file)
Send it to the other user using the same process as that of sending other files.

The other person should save the file to a location on their computer and use the “File|Open...” of the List menu
(visible with the list box is highlighted) to open the file.



Checking Tools

Paratext comes with several basic checks that the Translator should use.

It is possible to create “custom” checks as needed (consult a computer expert if help is needed with this).

It is important that the Chapter/Verse check be done first because Paratext locates errors based on the
correct chapters and verses.

Paratext prefers that books with a single chapter have \c 1 at the beginning. This helps in the location of errors. The
chapter number does not need to be printed in the published texts.

Deleting a Project

Once you have finished with a project, the project can be “deleted” from your projects.
**Always make a backup of the project before deleting it. When the project is deleted from Paratext all
the files are deleted from the computer!**

To Delete a Project (or a file)
Click on the project you want to delete so that it is the active project (you may need to Open the Project).

Go to Tools|Delete Entire Project...

Make sure the Project you wish to delete is named.

Make sure the “Delete Entire Project” box is checked (if this box is not checked you can choose individual books to
delete from the Choose list).

Click on OK. You will be given one more chance to verify that the data is correct before the deletion is completed.

Miscellaneous Hints

Many Paratext windows depend upon the font settings of Internet Explorer. Thus, it may be necessary to adjust the
“fonts” setting on the Internet Explorer Options page to use the Charis SIL font (this applies to XP).

Paratext Website

Main Paratext Page
http://paratext.ubs-translations.org/Home.html
On the Registered User Resource page there are updates to Paratext as well as new translation resources that may
not be available on the CDs.

More Help

Help files in each of the programs can be very useful - check there first!
Phil Leckrone: language_software_amareasil@sil.org
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